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TCalc
Mac OS v7.0 or later
250K bytes RAM
200K bytes disk space
Any Mac or compatible manufactured after 1987 (MacPlus or later)

❖ You may use this software on any computer you like.
❖ You may NOT use it on more than 1 computer at a time unless you

 have purchased more than 1 copy. Then you may use it  concurrently
on as many computers as you would like up to the number of copies
of the software that you own.

❖ You may NOT sell or give this software to someone else unless it is
the official DEMO copy distributed by Bleu Rose Ltd.

❖ Technical questions must be submitted in writing (either by letter,
FAX or E-Mail).

❖ No new versions of this software will be provided by Bleu Rose
Ltd. unless an additional license fee is paid.

❖ Full Refunds will be paid for ANY reason. Requests for a refund
MUST be submitted in writing (via letter, E-Mail or FAX) no later
than 60 days from the date of the original sale of this software. After
60 days, no refunds will be made.

TCalc  is supplied as a self-extracting StuffIt archive file. Most browsers
will extract the files automatically. If not, double click on the archive to
extract the files. The archive contains 6 files:
TCalc - the Calculator application.
Read about TCalc - a copy of the file you are reading
TCalc Documentation.pdf - the TCalc  Instruction manual in Adobe

Acrobat™ format.
Prepare your Order - an application that helps you pay for

TCalc  via EMail or traditional Mail.
How To Order - instructions for ordering including us-

ing Prepare your Order.Prepare your Or-
der helps you order TCalc.

Your License Key - Information about the License Key that
you need to turn the demo into  the com
mercial version.

Terms and Conditions
(See last section of this
manual for a full text)

License Agreement (synopsis)

Installing TCalc

System Requirements
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A typical calculator window looks like this:

Each Calculator Window contains 4 editable fields. The top 2 fields are
designated as “Time Code” fields. The bottom 2 are “Frame Number”
fields.

When a new Calculator Window is opened (you may open as many as
you like), the caret cursor (a vertical line) is automatically placed in the
top left edit field just to the right of the 8-digit time code value of
00:00:00:00. This field is designed for entering time code values. You
will find it very easy to enter and change the contents of the 2 Digit
Time Code fields using the keypad keys of your keyboard. Attempting
to use the mouse to select and modify the contents of the 2 Digit Time
Code fields will be tedious and time-consuming. Thus, you should
become familiar with what the keypad keys do and make use of them
when entering or changing the contents of Time Code fields. The keypad
keys are described in this section under the topic titled “Keyboard
Shortcuts”.

1) A frame number cannot be larger than 29;
2) Seconds cannot be larger than 59;
3) Minutes cannot be larger than 59;
4) Hours cannot be larger than 39;

If the “Drop Frame” box is checked and the Time Code value you enter
is actually a “dropped frame” value, a warning message will appear.
Refer to the “Background” section for a description of what frame
numbers are “dropped” (and therefore ar undefined or not allowed).

1) A frame number cannot be larger than 24;
2) Seconds cannot be larger than 59;
3) Minutes cannot be larger than 59;
4) Hours cannot be larger than 39;

When you want to calculate using Frame Numbers, you should enter
numbers into the 2 lower edit fields of the Calculator Window. These

Time Code

Entering Numbers

Rules for  NTSC
Time Code values:

Rules for PAL
Time Code values:

Frame Numbers

Calculator
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values are pure numbers. Most of the keypad shortcuts are not available
when entering Frame Numbers. See the section titled “Keyboard
Shortcuts” for a description of keypad keys and what they do when
you are entering Frame Numbers or Time Code values.

1) A frame number cannot be larger than 4,319,999.
2) A frame number cannot be smaller than 0.

1) A frame number cannot be larger than 4,319,679.
2) A frame number cannot be smaller than 0.

1) A frame number cannot be larger than 3,599,999.
2) A frame number cannot be smaller than 0.

As you enter values into the edit fields of the Calculator Window,
calculations are immediately performed and displayed.

The calculator will indicate an error:
1) If the calculated value is less than 0;
2) If the calculated value is more than 4,319,999 (NTSC), 4,315,679

(Drop Frame) or 3,599,999 (PAL);

The type of calculation performed (addition or subtraction) is
determined by what is displayed on the screen. To change the calculation
from addition to subtraction, press the keypad “-” key. To change the
calculation from subtraction to addition, press the keypad “+” key.
Alternatively, you can change the type of calculation being performed
by moving the mouse cursor over the top of the addition (or subtraction)
sign and clicking the mouse button.

Click the mouse button when the mouse cursor is inside this part of the
window to close the window.

Click the mouse button when the mouse cursor is inside this part of the
window to display (or hide) an illustration of what the keypad keys do
when you press them. If the illustration is currently visible, clicking
this box will hide the illustration.

Click the mouse button when the mouse cursor is inside this button to
close the Calculator window containing the button. Alternatively, you
can press the <Return> key to perform the same action. When the
window closes, all of it’s contents will be discarded.

Click the mouse button when the mouse cursor is inside this button to
copy the current calculated value to the Clipboard. If the caret cursor (a
vertical line) is blinking in one of the Time Code Format edit areas, the
saved value will be in time code format (HH:MM:SS: FF). If it is blinking
in one of the Frame Format edit fields, the saved value will be in frame
number format.

Rules for NTSC
Frame number values

Rules for Drop
Frame Values

Rules for PAL frame
number values

+ or -

Close box

Zoom box

“OK” Button

“Save Result” Button
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TCalc's Menus

Click the mouse button when the cursor is inside this button to display
(or hide) an illustration of what the keypad keys do when you press
them. If the illustration is currently visible, clicking this button will
hide the illustration.

Selecting this option will cause the values displayed in the window to
be based on a frame rate of 25 frames per second.

Selecting this option will cause the values displayed in the window to
be based on a frame rate of 30 frames per second.

Selecting this option will cause the values displayed in the window to
be based on a frame rate of 29.97 frames per second. Note that the “Drop
Frame” option is not available when you are using the PAL frame rate
choice.

The items on this menu perform the following functions:

Selecting this item opens a new calculator window. You may open as
many calculator windows as you like. Each calculator is independent
of the others. That is, in one window you can calculate values in PAL
and in another, you can use Drop-Frame, for example. The results of
the calculation in any window has no effect on the results in any other
window.

Selecting this item closes the currently active window. This could be a
Calculator window or the Clipboard window. Windows from other
applications are not affected by this option.

When you choose this item, the calculated result from the Calculator
that is currently active will be copied to the Clipboard.

This menu item provides you with a shortcut way to turn Balloon Help

“Help” Button

“PAL”

“NTSC”

“Drop Frame”

File Menu

New Calculator

Close

Save Result

Activate Balloon Help/
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on or off. It is primarily designed to give you a keyboard shortcut for
controlling Balloons. Note that TCalc comes with complete Balloon Help
support.

To exit from TCalc, select this menu item.

The items on this menu perform the following functions:

This item causes the contents of the current editable text field to be
copied to the Clipboard and then erased from the field.

This item causes the contents of the current editable text field to be
copied to the Clipboard.

This item causes the contents of the current editable text field to be
replaced with the contents of the Clipboard, if the Clipboard contains
text.

This item causes the contents of the current editable text field to be
erased. The contents of the Clipboard is not changed.

This item causes the contents of the current editable text field to be
selected and highlighted.

If you select this item, a window is opened at the bottom of your monitor
showing the contents of the Clipboard.

If the current window is a Calculator Window, pressing this key will
move the caret cursor to the other edit field of the same type. That is, if
the caret cursor is blinking in a Time Code field, it will be moved to the
other Time Code field. The same holds true for Frame Number fields.

Pressing this keystroke combination will move the caret cursor to the
edit field of the opposite type. That is, if the caret cursor is blinking in a
Time Code field, it will be moved to the corresponding Frame Number
field and vice versa.

Deactivate Balloon
Help

Quit

Edit Menu

Cut

Copy

Paste

Clear

Select All

Show Clipboard

Tab

Shift tab

Keyboard Shortcuts
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Pressing this key will select (and highlight) the HOURS part of the
current Time Code edit field. If the current edit field is a Frame Number
field, this key does nothing.

Pressing this key will select (and highlight) the MINUTES part of the
current Time Code edit field. If the current edit field is a Frame Number
field, this key does nothing.

Pressing this key will select (and highlight) the SECONDS part of the
current Time Code edit field. If the current edit field is a Frame Number
field, this key does nothing.

Pressing this key will select (and highlight) the FRAMES part of the
current Time Code edit field. If the current edit field is a Frame Number
field, this key does nothing.

Pressing this key will tell the calculator to perform a SUBTRACTION
operation.

Pressing this key will tell the calculator to perform a ADDITION
operation.

Pressing this key will tell the calculator to replace the current selection
with ZEROs.

Pressing this key will tell the calculator that you intend to only enter 1
digit of the 2 digits selected. When you select part of a Time Code field,
2 digits are highlighted. After you enter the first digit, the selected value
will be replaced with that digit preceded by a zero. If you want to keep
the leading zero in the final number, just press Enter. The leading zero
will be preserved. If the current edit field is a Frame Number field, this
key does nothing.

This keystroke combination is the same as selecting the “New
Calculator” option of the File menu. It opens a new Calculator Window.
You may open as many Calculator Windows as you like. Each one is
independent of the others.

This keystroke combination is the same as selecting the “Close” option
of the File menu. It closes the current window. If that window is a
Calculator Window, all of the window’s contents will be discarded.

 This keystroke combination is the same as selecting the “Save Result”
option of the File menu. It copies the calculated value displayed in the
current Calculator Window. If the current window is not a Calculator
Window, this keystroke combination is not available.

Clear (on the keypad)

= (on the keypad)

/ (on the keypad)

* (on the keypad)

- (on the keypad)

+ (on the keypad)

. (on the keypad)

Enter (on the keypad)

File Menu Shortcuts
N

W

S

Command Key Shortcuts

⌘

⌘

⌘
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This keystroke combination activates (or deactivates) Balloon Help. The
File menu has an item that performs the same action.

This keystroke combination is the same as selecting the “Quit” option
of the File menu. It stops TCalc and returns you to the Finder.

This keystroke combination is the same as selecting the “Cut” option
of the Edit menu. It deletes the editable characters that are currently
highlighted. Behind the scenes, it copies the same characters to the
Clipboard.

This keystroke combination is the same as selecting the “Copy” option
of the Edit menu. It copies the editable characters that are currently
highlighted to the Clipboard.

This keystroke combination is the same as selecting the “Paste” option
of the Edit menu. It inserts the contents of the Clipboard into the current
edit field just in front of the caret cursor (vertical line). If the Clipboard
contains something besides a number, a warning is displayed.

This keystroke combination is the same as selecting the “Select All”
option of the Edit menu. It highlights all of the characters in the current
edit field.

All other keyboard keys (or combinations) do the same thing as they
always did.

SMPTE time code is a broadcast standard time which is recorded in the
HH:MM:SS:FF format where HH represents hours, MM refers to
minutes, SS is seconds and FF is a frame number.

In countries adhering to the NTSC standard such as the United States,
FF is a number between 00 and 29. This gives the television frame rate
of 30 frames per second (well, almost... keep reading). Each frame is
made of two interlaced fields, so video data resolution of 1/60 of a
second is possible with professional VCR equipment.

Simple enough so far. The problem comes because NTSC actually uses
a frame rate of 29.97 frames per second. So a “Drop Frame” counting
scheme is used instead.

During the drop-frame cycle, error accumulates at the rate of .001
seconds per frame. When end cycle minute is reached, a .066 second
compensation is made by dropping 2 frames. By convention, the frame
numbers that are dropped are the 00 and 01 frames at the start of each
minute. When the minutes value is an even multiple of 10, no frames
are dropped.

H

Q

Edit Menu shortcuts
X

C

V

A

⌘

⌘

⌘

⌘

⌘

⌘

Background



10   Bleu Rose T Calc Manual

SMPTE Time Code

Number of Frames
(10 minutes total)
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Below you can see an image of the saw tooth pattern this creates in
time code over a ten minute period.

The plot shows a total of ten minutes worth of frames.
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Bleu Rose Limited
REDISTRIBUTION NOT PERMITTED

BY CLICKING ON THE "Purchase" BUTTON OR OPENING THE
PACKAGE, YOU ARE CONSENTING TO BE BOUND BY THIS
AGREEMENT. IF YOU DO NOT AGREE TO ALL OF THE TERMS OF
THIS AGREEMENT, CLICK THE "Quit" BUTTON AND THE
INSTALLATION PROCESS WILL NOT CONTINUE OR RETURN THE
PRODUCT TO THE PLACE OF PURCHASE FOR A FULL REFUND.

This Agreement has 3 parts. Part I applies if you have not purchased a
license to the accompanying software (the "Software"). Part II applies if
you have purchased a license to the Software. Part III applies to all
license grants. If you initially acquired a copy of the Software without
purchasing a license and you wish to purchase a license, contact Bleu
Rose Limited ("Bleu Rose") on the Internet at http://www.bleurose.com.

Bleu Rose grants you a nonexclusive license to use the Software free of
charge if your use of the Software is for the purpose of evaluating
whether to purchase an ongoing license to the Software. If you are using
the Software free of charge, you are not entitled to hard-copy
documentation, support or technical assistance. If you fit within the
description above, you may use the Software in the manner described
in Part III below under "Scope of Grant."

Disclaimer of Warranty
Free of charge Software is provided on an "AS IS" basis, without
warranty of any kind, including without limitation the warranties of
merchantability, fitness for a particular purpose and non-infringement.
The entire risk as to the quality and performance of the Software is
borne by you. Should the Software prove defective, you and not Bleu
Rose assume the entire cost of any service and repair. In addition, the
security mechanisms implemented by Bleu Rose software have inherent
limitations, and you must determine that the Software sufficiently meets
your requirements. This disclaimer of warranty constitutes an essential
part of the agreement. SOME JURISDICTIONS DO NOT ALLOW
EXCLUSIONS OF AN IMPLIED WARRANTY, SO THIS DISCLAIMER
MAY NOT APPLY TO YOU AND YOU MAY HAVE OTHER LEGAL
RIGHTS THAT VARY BY JURISDICTION.

Subject to payment of applicable license fees, Bleu Rose grants to you a
nonexclusive license to use the Software and accompanying
documentation ("Documentation") in the manner described in Part III
below under "Scope of Grant."

PART I – TERMS
APPLICABLE WHEN
LICENSE FEES NOT

(YET) PAID (LIMITED
TO EVALUATION,

EDUCATIONAL AND
NONPROFIT USE)

GRANT.

Complete License Agreement
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Limited Warranty
Bleu Rose warrants that for a period of sixty (60) days from the date of
acquisition, the Software, if operated as directed, will substantially
achieve the functionality described in the Documentation. Bleu Rose
does not warrant, however, that your use of the Software will be
uninterrupted or that the operation of the Software will be error-free.
Bleu Rose also warrants that the media containing the Software, if
provided by Bleu Rose, is free from defects in material and
workmanship and will so remain for sixty (60) days from the date you
acquired the Software. Bleu Rose's sole liability for any breach of this
warranty shall be, in Bleu Rose's sole discretion: (i) to replace your
defective media; or (ii) to advise you how to achieve substantially the
same functionality with the Software as described in the Documentation
through a procedure different from that set forth in the Documentation;
or (iii) if the above remedies are impracticable, to refund the license fee
you paid for the Software. Repaired, corrected, or replaced Software
and Documentation shall be covered by this limited warranty for the
period remaining under the warranty that covered the original Software,
or if longer, for thirty (30) days after the date (a) of shipment to you of
the repaired or replaced Software, or (b) Bleu Rose advised you how to
operate the Software so as to achieve the functionality described in the
Documentation. Only if you inform Bleu Rose of your problem with
the Software during the applicable warranty period and provide
evidence of the date you purchased a license to the Software will Bleu
Rose be obligated to honor this warranty. Bleu Rose will use reasonable
commercial efforts to repair, replace, advise or, for individual consumers,
refund pursuant to the foregoing warranty within 30 days of being so
notified.

THIS IS A LIMITED WARRANTY AND IT IS THE ONLY WARRANTY
MADE BY Bleu Rose. Bleu Rose MAKES NO OTHER EXPRESS
WARRANTY AND NO WARRANTY OF NON-INFRINGEMENT OF
THIRD PARTIES' RIGHTS. THE DURATION OF IMPLIED WARRAN-
TIES, INCLUDING WITHOUT LIMITATION, WARRANTIES OF
MERCHANTABILITY AND OF FITNESS FOR A PARTICULAR
PURPOSE, IS LIMITED TO THE ABOVE LIMITED WARRANTY
PERIOD; SOME JURISDICTIONS DO NOT ALLOW LIMITATIONS
ON HOW LONG AN IMPLIED WARRANTY LASTS, SO
LIMITATIONS MAY NOT APPLY TO YOU. NO Bleu Rose DEALER,
AGENT, OR EMPLOYEE IS AUTHORIZED TO MAKE ANY
MODIFICATIONS, EXTENSIONS, OR ADDITIONS TO THIS
WARRANTY. If any modifications are made to the Software by you
during the warranty period; if the media is subjected to accident, abuse,
or improper use; or if you violate the terms of this Agreement, then this
warranty shall immediately be terminated. This warranty shall not
apply if the Software is used on or in conjunction with hardware or
software other than the unmodified version of hardware and software
with which the software was designed to be used as described in the

PART II
(TERMS APPLICABLE
WHEN LICENSE FEES

PAID GRANT)
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Documentation. THIS WARRANTY GIVES YOU SPECIFIC LEGAL
RIGHTS, AND YOU MAY HAVE OTHER LEGAL RIGHTS THAT VARY
BY JURISDICTION.

Scope of Grant
You may:
❖ Use the Software on any single computer;
❖ Use the Software on a network, provided that each person accessing

the Software through the network must has a copy licensed to
that person;

❖ Use the Software on a second computer so long as only one copy is
used at a time;

❖ Copy the Software for archival purposes, provided any copy  must
contain all of the original Software's proprietary notices;

You may not:
❖ Permit other individuals to use the Software except under the terms

listed previously;
❖ Permit concurrent use of the Software;
❖ Modify, translate, reverse engineer, decompile, disassemble (except

to the extent applicable laws specifically prohibit such  restriction),
or create derivative works based on the Software;

❖ Copy the Software other than as specified above;
❖ Rent, lease, grant a security interest in, or otherwise transfer

rights to the Software.
❖ Remove any proprietary notices or labels on the Software.

Title
Title, ownership rights, and intellectual property rights in the Software
shall remain in Bleu Rose and/or its suppliers. The Software is protected
by the copyright laws and treaties. Title and related rights in the content
accessed through the Software is the property of the applicable content
owner and may be protected by applicable law. This License gives you
no rights to such content.

Termination
The license will terminate automatically if you fail to comply with the
limitations described herein. On termination, you must destroy all
copies of the Software and Documentation.

Export Controls
None of the Software or underlying information or technology may be
downloaded or otherwise exported or reexported (i) into (or to a national
or resident of) Cuba, Iraq, Libya, Yugoslavia, North Korea, Iran, Syria
or any other country to which the U.S. has embargoed goods; or (ii) to
anyone on the U.S. Treasury Department's list of Specially Designated
Nationals or the U.S. Commerce Department's Table of Denial Orders.
By downloading or using the Software, you are agreeing to the foregoing

PART III
TERMS APPLICABLE

TO ALL LICENSE
GRANTS
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and you are representing and warranting that you are not located in,
under the control of, or a national or resident of any such country or on
any such list.

In addition, if the licensed Software is identified as a not-for-export
product (for example, on the box, media or in the installation process),
then the following applies: EXCEPT FOR EXPORT TO CANADA FOR
USE IN CANADA BY CANADIAN CITIZENS, THE SOFTWARE AND
ANY UNDERLYING TECHNOLOGY MAY NOT BE EXPORTED
OUTSIDE THE UNITED STATES OR TO ANY FOREIGN ENTITY OR
"FOREIGN PERSON" AS DEFINED BY U.S. GOVERNMENT
REGULATIONS, INCLUDING WITHOUT LIMITATION, ANYONE
WHO IS NOT A CITIZEN, NATIONAL OR LAWFUL PERMANENT
RESIDENT OF THE UNITED STATES. BY DOWNLOADING OR US-
ING THE SOFTWARE, YOU ARE AGREEING TO THE FOREGOING
AND YOU ARE WARRANTING THAT YOU ARE NOT A "FOREIGN
PERSON" OR UNDER THE CONTROL OF A FOREIGN PERSON.

LIMITATION OF LIABILITY. UNDER NO CIRCUMSTANCES AND
UNDER NO LEGAL THEORY, TORT, CONTRACT, OR OTHERWISE,
SHALL Bleu Rose OR ITS SUPPLIERS OR RESELLERS BE LIABLE TO
YOU OR ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY CHAR-
ACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR
LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR
MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL
DAMAGES OR LOSSES. IN NO EVENT WILL Bleu Rose BE LIABLE
FOR ANY DAMAGES IN EXCESS OF THE AMOUNT Bleu Rose
RECEIVED FROM YOU FOR A LICENSE TO THE SOFTWARE, EVEN
IF Bleu Rose SHALL HAVE BEEN INFORMED OF THE POSSIBILITY
OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.
THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY
FOR DEATH OR PERSONAL INJURY TO THE EXTENT APPLICABLE
LAW PROHIBITS SUCH LIMITATION. FURTHERMORE, SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES,
SO THIS LIMITATION AND EXCLUSION MAY NOT APPLY TO YOU.

High Risk Activities
The Software is not fault-tolerant and is not designed, manufactured
or intended for use or resale as on-line control equipment in hazardous
environments requiring fail-safe performance, such as in the operation
of nuclear facilities, aircraft navigation or communication systems, air
traffic control, direct life support machines, or weapons systems, in
which the failure of the Software could lead directly to death, personal
injury, or severe physical or environmental damage ("High Risk
Activities"). Bleu Rose and its suppliers specifically disclaim any express
or implied warranty of fitness for High Risk Activities.
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Miscellaneous
If the copy of the Software you received was accompanied by a printed
or other form of "hard-copy" End User License Agreement whose terms
vary from this Agreement, then the hard-copy End User License
Agreement governs your use of the Software. This Agreement represents
the complete agreement concerning this license and may amended only
by a writing executed by both parties. THE ACCEPTANCE OF ANY
PURCHASE ORDER PLACED BY YOU IS EXPRESSLY MADE
CONDITIONAL ON YOUR ASSENT TO THE TERMS SET FORTH
HEREIN, AND NOT THOSE IN YOUR PURCHASE ORDER. If any
provision of this Agreement is held to be unenforceable, such provision
shall be reformed only to the extent necessary to make it enforceable.
This Agreement shall be governed by California law (except for conflict
of law provisions). The application the United Nations Convention of
Contracts for the International Sale of Goods is expressly excluded.

U.S. Government Restricted Rights
Use, duplication or disclosure by the Government is subject to
restrictions set forth in subparagraphs (a) through (d) of the Commercial
Computer-Restricted Rights clause at FAR 52.227-19 when applicable,
or in subparagraph (c)(1)(ii) of the Rights in Technical Data and
Computer Software clause at DFARS 252.227-7013, or at 252.211-7015,
or to Bleu Rose's standard commercial license, as applicable, and in
similar clauses in the NASA FAR Supplement. Contractor/
manufacturer is Bleu Rose Limited, Post Office Box 5536, Hacienda
Heights, California 91745-0536, U.S.A..
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